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2 Configurarea TCP/IP, harta Internetului  

2.1 Obiective:  
• Identificarea adreselor IP, adreselor MAC şi adresei Default Gateway pentru reţeaua 

în care se va desfăşura laboratorul "Reţele de Calculatoare" 
• Toate datele aflate vor fi notate într-un tabel pentru a fi folosite la lucrările 

viitoare. 
• Testați Conectivitatea Rețelei Folosind Ping 
• Urmăriți Ruta către un Server Remote folosind Windows Tracert 
• Urmăriți o Rută la un Server Remote folosind Instrumente Software și bazate pe Web 

Partea 4: Comparați Rezultatele Comenzii Traceroute 
 
 

2.2 Obţinerea informaţiilor de bază despre TCP / IP 
În  funcţie  de  sistemul  de  operare  comenzile  pentru  aflarea  configurării 

protocolului TCP / IP diferă, astfel: 
winipcfg – pentru Windows 95, 98 
ipconfig –  pentru Windows XP, 2000, 2003, 2010 
 
Se va folosi fereastra de comandă în mod prompt (mod text) ca în MS-DOS Acest 

lucru se face prin următoarea succesiune de comenzi: 
 
1. Start > Programs > Accessories > Command Prompt 
sau 
2. Start > Programs > Command Prompt 
sau  
3. Start > Run > Open: cmd 
sau 
4. Search > cmd   
 
Şi în funcţie de sistemul de operare se scrie comanda: ipconfig. 
În urma acestei comenzi pe ecran ni se afișează informațiile: 
IP Address ……………….:  
Subnet Mask ……………..:  
Default Gateway …………: 
 
Pentru a afla mai multe informaţii : 
- se dă comanda ipconfig / all 
 
Următoarele informații suplimentare sunt disponibile, şi trebuie notate: 
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Parametru Descriere Valoare obţinută 
Host name Numele calculatorului  
Description Numele producătorului cipsetului plăcii de reţea  
Physical 
Address Adresa MAC  

Dhcp Enable Activarea serverului DHCP  

IP Address Adresa IP (Internet Protocol) atribuită plăcii de reţea  

Subnet Mask Masca reţelei (a adresei IP)  
Default 
Gateway: 

Poarta implicită de ieşire din reţeaua locală, ieşire 
către Internet 

 

DHCP server Adresa IP a serverului DHCP (Dynamic Host 
Configuration Protocol) 

 

DNS server Adresa IP a serverului DNS (Domain Name System)  

Link-Local IPv6 
Address 

Adresa locala IPv6  

 
Pe tablă se va desena şi completa următorul tabel, Completați următorul tabel 

pentru toate calculatoarele 
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Nr. 
crt. 

Nume 
PC 

Placă reţea / 
Adresa MAC 

Adresa IP / 
Subnet Mask 

Default 
Gateway DHCP server DNS server IPv6 

1 Home-pc Realtek 
00-E0-4C-86-1F-97 

192.168.2.200 
255.255.255.0 192.168.2.1 192.168.2.1 213.154.124.1 fe80::6192:6f76

:29a7:24f7%19 
2        
3        
4        
5        
6        
7        

 
Notă: 
Tipuri de adrese IPv4, IPv6: 
 

Tip IPv6 Echivalent IPv4 Valoarea primului 
hexet Descriere 

Adresă globală 
unicast  

Publică 2000 – 3FFF O adresp IP rutabilă, cu ieșire la Internet 
atribuită de ISP-ul local. 

Loopback  
(nod local) 

Loopback 
127.0.0.1 

0000 – 00FF::1 Folosită pentru testarea internă a 
protocolului TCP/IP 

Link-local 169.254.x.x/16 FE80-FEBF Adresă unicast ce identifică gazda în 
rețeaua locală, când nu funcționează 
DHCP (nu este rutabilă) 

Unique-local  Adresă private 
10.x.x.x/8 
172.16.x.x-
172.31.x.x/12 
192.168.x.x/16 

FC00 – FEBF Adresă unicast care este atribuită unei 
gazed pentru a o identifica într-o 
subrețea specific în rețeaua locală (nu 
este rutabilă) 

Adrese 
multicast 

224.x.x.x FF00- FFFF Folosită pentru transmisii multicast (RIP) 

 
 

 

Concluzii: 
1. Ce puteţi spune despre: 

a. adresele IP ale calculatoarelor 
b. subnet mask 
c. default gateway 
d. nume PC 

2. Ce este comun la adresele IP ale Calculatoarelor. 
3. Dar la adresele MAC ??? 
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2.3 Utilizarea comenzilor ping şi tracert 

ping = packet internet groper 
tracert = traceroute 
 
În principiu, comanda ping se folosește pentru a verifica existenta conexiunii 
d.p.d.v. electric între calculatorul gazdă și calculatorul a cărui adresă IP o 

introducem în cadrul comenzii. 
Comand tracert este folosită pentru a urmări traseul urmat de pachete până la 

adresa destinație. 
Pentru a afla mai multe informaţii despre cele două comenzi, puteţi da: 
 
ping / ?  
tracert /? 
 
Mersul lucrării: 
1. Daţi ping la adresa IP de gateway: ping 192.168.1.1 
2. Daţi ping la adresa IP a serverului DHCP şi DNS: 
3. Daţi ping la adresa de loopback: ping 127.0.0.1 
4. Daţi ping la numele unui calculator din reţea, de ex: ping comp1 
5. Daţi ping la o adresă oarecare IP şi vedeţi ce se întâmplă 
 

2.3.1 Rolul serverului DNS: 
Serverul DNS ţine un tabel în care sunt trecute numele unor calculatoare (servere) 

din Internet şi adresa lor IP. Este mult mai uşor să ţinem minte adresa www.yahoo.com 
decât adresa sa IP. 

Dacă dăm ping la serverul yahoo, îi vom afla şi adresa IP: 
 

 
  
tracert contactează fiecare router de trei ori. Compară rezultatele  obţinute pentru 

a verifica consistenţa rutei. Măsoară timpul de întârziere între fiecare două routere 
alăturate. 

 
La prompt tipăriţi : tracert www.yahoo.com şi observaţi rezultatele 
 
Daţi comanda tracert către: 

• oricare altă adresă IP sau nume de domeniu (de ex: www.msm.com); 
• adresă a unui calculator din reţea (în afară de adresa calculatorului la care vă 

aflaţi); 
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2.3.2 Descrierea comenzii tracert 
 
Numărul de routere aflat între noi şi destinație se poate afla folosind comanda 

tracert. 
Rezultatul oferă adresele IP sau numele routerelor tranzitate. Sintaxa pentru 

sisteme Windows este: 
 
tracert [-d][-h maximum hops][-j host_list][-w timeout] target_name  
 
target_name este numele domeniului (de exemplu yahoo.com) sau adresa IP. 
-d   Do not resolve addresses to hostname 
-h maximum_hops Maximum number of hops to search for target 
-j host-list  Loose source route along host-list 
-w timeout  Wait timeout miliseconds for each repply 
 

2.3.3 Descrierea comenzii ping 
 
Ping prescurtare de la Packet InterNet Groper, este o comandă folosită pentru a 

verifica dacă pachetele de date ajung la o adresa (destinație) fără erori. 
Sintaxa pentru sisteme Windows este: 
 
ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS] 
[-r count] [-s count] [[-j host-list] | [-k host-list]] 
[-w timeout] destination-list 
 
destination-list este numele domeniului (de exemplu yahoo.com) sau adresa IP. 
 
-t Pings the specified host until stopped 

To see statistics and continue - type Control-Break 
To stop - type Control-C 

-a Resolve addresses to hostnames 
-n  count Number of echo requests to send 
-l  size Send buffer size 
================================= 
-f  Set Don't Fragment flag in packet 
-i TTL  Time To Live 
-v TOS  Type Of Service 
-r count Record route for count hops 
-s count Timestamp for count hops 
-j host-list Loose source route along host-list 
-k host-list Strict source route along host-list 
-w timeout Timeout in milliseconds to wait for each reply 
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TTL (Time To Live) este un câmp de 8 biţi din header-ul IP şi este conţinut de al 

9-lea octet din cei 20. 
Câmpul TTL este stabilit de cel care trimite datagrama şi este decrementat de 

fiecare host (echipament activ de reţea) aflat în ruta către destinaţie. Dacă acest câmp 
ajunge la 0 înainte ca datagrama să ajungă la destinaţie datagrama va fi ştearsă şi se va 
genera o eroare ICMP (11 - Time Exceeded) care va fi trimisă înapoi trimiţătorului. 
Scopul câmpului TTL este de a evita situaţia în care o datagramă nelivrata continuă să 
circule prin Internet. 

 

2.4 Testarea Conectivității Rețelei Folosind Ping 
Determinați dacă serverul remote este accesibil. 
• În linia de comandă, tastați ping www.cisco.com. 

 
 
• Prima linie din output afișează Fully Qualified Domain Name (FQDN) 

e144.dscb.akamaiedge.net. Urmează adresă IP 23.1.48.170. Cisco 
găzduiește același conținut web pe diferite servere din întreaga lume 
(cunoscute ca oglinzi). Așadar, în funcție de locul unde vă aflați din punct de 
vedere geografic, FQDN și adresa IP vor fi diferite. 

• Din această porțiune a output-ului: 

 
 
4 ping-uri au fost trimise și a fost primit câte un răspuns de la fiecare ping. 

Deoarece s-a răspuns la fiecare ping, pierderea de pachete este de 0%. În medie, durează 
48 ms (milisecunde) pentru ca pachetele să traverseze rețeaua. O milisecundă înseamnă 
1/1,000 dintr-o secundă. 

OBS: Dacă primul pachet ICMP a expirat, acest lucru ar putea fi rezultatul 
calculatorului care transformă adresa de destinație. (procesul ARP) Acest lucru nu ar 
trebui să se întâmple dacă repetați comanda ping deoarece adresa este acum aflată în 
memoria cache. 

Streaming video și jocurile online sunt două aplicații care sunt afectate atunci 
când se pierd pachete sau când apare o conexiune de rețea lentă. O determinare mai 
exactă a vitezei conexiunii la Internet poate fi determinată trimițând 100 ping-uri, în loc 
de 4 implicite. Iată cum trebuie să faceți asta: 

 
Iată cum arată output-ul: 
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Acum dați ping la site-urile web Regional Internet Registry (RIR) localizate în 

diferite părți ale lumii. 
Pentru Africa: 

 
Pentru Australia: 

 
Pentru Europa: 

 

 
 

Pentru America de Sud: 

 
 

 

2.5 Urmăriți o Rută către un Server Remote folosind Tracert 
 
Determinați ce rută a traficului de Internet duce la serverul remote. 
Având în vedere că a fost verificată accesibilitatea de bază folosind instrumentul 

ping, este util să priviți cu atenție la fiecare segment de rețea traversat. Pentru a face asta, 
instrumentul tracert va fi utilizat. 

 
a) În linia de comandă, tastați tracert www.cisco.com. 
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b) Salvați output-ul comenzii tracert într-un fișier text după cum urmează: 
1) Dați clic dreapta pe bara de titlu din fereastra Command Prompt și alegeți 

Edit > Select All. 
2) Dați din nou clic dreapta pe bara de titlu din fereastra Command Prompt și 

alegeți Edit > Copy. 
3) Deschideți Notepad: Windows Start > All Programs > Accessories > 

Notepad. 
4) Pentru a lipi output-ul în Notepad, alegeți Edit > Paste. 
5) Alegeți File > Save As și salvați fișierul Notepad pe desktop sub forma 

tracert1.txt. 
c) Executați tracert pentru fiecare site web de destinație și salvați output-ul în fișiere 

numerotate secvențial. 
C:\> tracert www.afrinic.net  
C:\> tracert www.lacnic.net 

d) Interpretarea output-urilor tracert 
Rutele urmărite pot trece peste mai multe hopuri și printr-un număr diferit de ISP-

uri, în funcție de dimensiunea ISP-urilor și de locația hosturilor sursă și destinație. Fiecare 
hop reprezintă un router. Un router este un tip specializat de calculator utilizat pentru a 
direcționa traficul pe Internet. Imaginați-vă că faceți o excursie cu mașina prin mai multe 
țări folosi autrostrăzi.În puncte diferite ale călătoriei ajungeți la o intersecție unde trebuie 
să selectați din mai multe drumuri. Imaginați-vă acum că există un echipament la fiecare 
intersecție care vă direcționează să urmați drumul corect până la destinația finală. Asta 
face un router pentru pachete într-o rețea. 

Deoarece calculatoarele comunică mai mult în numere, nu în cuvinte, routerele 
sunt identificate în mod unic folosind adrese IP (numere cu formatul x.x.x.x). 
Instrumentul tracert vă arată ce cale urmează un pachet pentru a accesa destinația finală. 
Instrumentul tracert vă dă o idee cu privire la rapiditatea cu care trece traficul prin fiecare 
segment al rețelei. Trei pachete sunt trimise la fiecare router din cale, iar timpul de 
revenire este măsurat în milisecunde. Acum utilizați această informație pentru a analiza 
rezultatele comenzii tracert pe www.cisco.com. Mai jos este întreaga comanda 
traceroute: 

Mai jos este breakdown-ul: 
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În output-ul de mai sus, pachetele rezultate în urma comenzii tracert călătoresc de 

la calculatorul sursă către gateway-ul default al routerului local ((hop 1: 192.168.1.1) si 
mai departe către routerul POP (hop 2: 10.18.20.1) al ISP-ului. Fiecare ISP are mai multe 
routere POP. Aceste routere POP sunt la marginea rețelei ISP-ului și sunt mijloacele prin 
care clienții se conectează la Internet. Pachetele călătoresc de-a lungul rețelei Verizon 
timp de 2 hopuri și apoi ajung la un router care aparține lui alter.net. Asta ar putea însemna 
că pachetele au ajuns la un alt ISP. Acest lucru este important deoarece uneori există 
pierderi de pachete în tranziția dintre ISP-uri, sau uneori un ISP este mai lent decât altul. 
Cum am putea afla dacă alter.net este un alt ISP sau același ISP? 

 
e) Există un instrument pe Internet denumit whois. Acesta ne permite să determinăm 

cine deține un nume de domeniu. Un instrument whois bazat pe web se găsește la 
http://whois.domaintools.com/.Acest domeniu este deținut și de Verizon, conform 
instrumentului whois bazat pe web. 

 
Pentru sumarizare, traficul de Internet pornește dintr-un calculator de domiciliu și 

călătorește către routerul de domiciliu (hop 1). Apoi se conectează la ISP și trece prin 
rețeaua sa (hopurile de la 2 la 7) până când ajunge la serverul remote (hop 8). Acesta este 
un exemplu relativ neobișnuit în care există doar un ISP implicat de la început până la 
final. Este un lucru obișnuit să existe două sau mai multe ISP- uri implicate așa cum se 
arată în următoarele exemple. 

 
f) Acum examinați un pachet care implică traficul de Internet care trece prin mai 

multe ISP-uri. Mai jos este tracert pentru www.afrinic.net: 

18 

http://www.afrinic.net/


Laborator Rețele de calculatoare v6-2019  Lucrarea nr.2 

 
 
Ce se întâmplă la hopul 7? level3.net este de la același ISP ca și hopurile 2-6 sau 

de la unul diferite? Folosiți instrumentul whois pentru a răspunde la această întrebare. 
  _ 
 

 
Ce se întâmplă la hopul 10 cu timpul necesar unui pachet să călătorească între 

Washington D.C. și Paris, în comparație cu hopurile 1-9? 
 

 
 

 
Ce se întâmplă la hopul 18? Realizați un whois lookup pe 168.209.201.74 folosind 

instrumentul whois.Cine deține această rețea? 
 
 

 
g) Tastați tracert www.lacnic.net. 

 

Traficul de Internet merge de la alter.net la level3.net.Instrumentul whois arată că 
reprezintă o companie/ISP separat(ă). 

La hopurile 1-9 majoritatea pachetelor traversează link-urile în 50 ms sau mai puțin.Pe link-
ul dintre Washington D.C. și Paris, timpul crește la 132 ms.. 

Timpul necesar traversării unui link în rețea este cuprins între 159 ms și 340 ms.Din cauza 
timpului crescut, probabil că traficul este mutat într-o rețea diferită din rețeaua de backbone de Level 
3.Folosind instrumentul whois, adresa IP (168.209.201.74) este deținută de African Network Information 
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Ce se întâmplă în hopul 7? 
 

 
 

 
 
 
 

  

Timpul în care un pachet traversează rețeaua crește în mod dramatic de patru ori mai mult, de la 
40 ms la 180 ms.Studenții au realizați un whois pe registro.br folosind instrumentul whois bazat pe web:
http://whois.domaintools.com/.?Dacă da, informația primită de ei nu a fost utilă.Studenții au mers la:
http://translate.google.com/ pentru a obține o traducere pentru Núcleo de Informação e Coordenação do
Ponto? Mai utilă ar fi o solicitare a motorului de căutare pentru “top domain .br” Acest lucru ne-ar fi arătat
că acum ne aflăm într-o rețea din Brazilia.Munca de detectiv pe Internet poate fi amuzantă! 
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Suplimentar. Pentru Acasa!! 
 

3 Urmăriți o Rută la un Server Remote folosind Instrumente 
Software și bazate pe Web 

 

3.1 Folosiți un instrument traceroute bazat pe web. 
Folosind http://www.subnetonline.com/pages/network-tools/online-tracepath.php  

pentru a urmări ruta la următoarele site-uri web: 
www.cisco.com www.afrinic.net 
Capturați și salvați output-ul în Notepad. www.cisco.com: 
 

 
  
 
În ce măsură traceroute-ul este diferit atunci când mergeți la www.cisco.com din 

ecranul de comandă (vezi Partea 1) în comparație cu situația când accesați din site-ul web 
online? (Rezultatele dumneavoastră pot varia în funcție de unde vă aflați din punct de 
vedere geografic și de ce ISP asigură conectivitate școlii dumneavoastră.) 

 
Tracer-ul din ecranul de comandă din Partea 1 s-a finalizat într-un server din 

Cambridge, Massachusetts. Traceroute-ul din site-ul web din Olanda a mers la un site 
oglindă din Olanda. Domeniul cisco.com este găzduit pe mai multe site-uri web sau 
oglinzi din întreaga lume. Acest lucru este realizat astfel încât timpul de acces la site să 
se realizeze cât mai repede din orice loc al lumii. 
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Comparați tracert-ul din Partea 1 care merge în Africa cu cel care merge în Africa 

din interfața web. Ce diferență ați observat? 
 
Ruta din Europa este într-un ISP diferit. Stabiliți cu studenții că nu există o singură 

rețea backbone a Internetului. De fapt, există mai multe backbone-uri pe Internet. Toate 
se conectează la Peering Points. Performanța din rețea pe un ISP ar putea fi foarte diferită 
față de performanța rețelei pe un ISP diferit. 

Unele traceroute-uri conțin prescurtarea asymm. Aveți idee ce înseamnă? Care 
este semnificația ei? 

 
Este o prescurtare pentru asymmetric. Asta înseamnă că pachetul de test a urmat o cale pentru 

a accesa destinație și o cale diferită pentru întoarcere. Închipuiți-vă că cineva conduce de acasă până în 
New York. În drum spre New York, observă că autostrada este congestionată iar traficul este lent. Poate 
decide să se întoarcă acasă folosind o rută diferită sau asimetrică. 

 

3.2 Folosiți VisualRoute Lite Edition 
VisualRoute este un program de traceroute patentat care poate afișa grafic 

rezultatele urmăririi căilor. 
a) Descărcați VisualRoute Lite Edition de la următorul link dacă nu este deja instalat:  

http://www.visualroute.com/download.html 
Dacă aveți probleme la descărcare sau instalare, cereți ajutor instructorului. 

Asigurați-vă că descărcați Lite Edition. 
b) Folosind VisualRoute 2010 Lite Edition, urmăriți rutele la www.cisco.com. 
c) Înregistrați adresele IP din cale în Notepad. 

 
 

3.3 Comparați Rezultatele lui Traceroute 
Comparați rezultatele lui traceroute la www.cisco.com din Părțile 2 și 3. 
 
Pasul 1: Afișați calea la www.cisco.com folosind tracert. 
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Pasul 2: Afișați calea la www.cisco.com folosind instrumentul bazat pe web de pe 
subnetonline.com. 
141.138.203.105 141.138.203.1 > 79.170.92.19 > 19.239.116.226 
 
Pasul 3: Afișați calea la www.cisco.com folosind VisualRoute Lite Edition. 

 
  
Toate utilitarele au folosit aceleași căi la www.cisco.com? Justificați. 
 
Urmărirea rutelor între aceeași sursă și aceeași destinația la momente diferite de timp 
poate produce rezultate diferite. Acest lucru se datorează ochiurilor din rețelele 
interconectate care cuprind abilitatea Internetului și a Protocoalelor Internetului să 
selecteze diferite căi prin care să trimită pachete. 
 
Reflecție 
Vizualizând traceroute prin trei instrumente diferite (tracert, web interface, and 
VisualRoute), există elemente pe care VisualRoute le furnizează însă celelalte două 
instrumente nu? 
 
Răspunsurile vor varia. Un astfel de element poate fi acela că VisualRoute evidențiază 
grafic durata de timp între hopuri. Evidențiind prin galben și roșu timpii lenți, este mai 
evident faptul că există probleme de rețea pe aceste link-uri. 
 

192.168.1.17 > 192.168.1.1 > 10.18.20.1 130.81.196.188 > 130.81.151.1 130.81.22.46 > 
152.63.9.249 > 

     

23 


	2 Configurarea TCP/IP, harta Internetului
	2.1 Obiective:
	2.2 Obţinerea informaţiilor de bază despre TCP / IP
	2.3 Utilizarea comenzilor ping şi tracert
	2.3.1 Rolul serverului DNS:
	2.3.2 Descrierea comenzii tracert
	2.3.3 Descrierea comenzii ping

	2.4 Testarea Conectivității Rețelei Folosind Ping
	2.5 Urmăriți o Rută către un Server Remote folosind Tracert

	3 Urmăriți o Rută la un Server Remote folosind Instrumente Software și bazate pe Web
	3.1 Folosiți un instrument traceroute bazat pe web.
	3.2 Folosiți VisualRoute Lite Edition
	3.3 Comparați Rezultatele lui Traceroute


